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1. Soạn thảo thư
1.1. Tạo mới Email
Tạo mail mới hoàn toàn

Để tạo một Email mới có các nhiều cách. Bạn có thể làm một trong các cách sau:

1) Nhấp vào biểu tượng New Mail Message

2) Nhấp vào File chọn New chọn tiếp Mail Message

3) Bạn có thể dụng phím tắt bàn phím: Ctrl + N 

Sau khi mở được form (biểu mẩu) email mới, bạn gõ địa chỉ Email người bạn muốn gửi vào hộp To và chủ đề vào hộp Subject. Nếu muốn gửi email đến nhiều người thì giữa các địa chỉ email người nhận được cách nhau bởi dấu ; (chấm phẩy). Sau đó bạn nhập nội dung chủ đề ở form bên dưới. Bước cuối cùng là bạn nhấp vào nút Send, thì email sẽ được gửi đi.
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1.1.1. Tạo thư trả lời

Thông thường khi bạn mở một email trong Outlook để đọc nội dung và bạn muốn trả lời một email này thì chỉ cần nhấp nút Reply hoặc Reply all. Một form email mới mở ra đã được ghi sẵn địa chỉ và lịch sử các nội dung đã trao đổi gửi đến người gửi email cho bạn. Bạn chỉ cần viết nội dung thông báo và nhấp vào nút Send. Việc nhấn Reply để trả lời thư không chỉ giúp bạn không phải nhập địa chỉ người nhận và tiêu đề thư mà còn giúp bạn quản lý luồng mail dễ dàng hệ thống hơn bởi vì hệ thống Email sẽ xâu chuỗi các thư reply qua lại này thành nhóm, khi bạn muốn xem lại toàn bộ nội dung các mail đã trao đổi về một vấn đề thì chỉ cần chọn phương thức xem theo hội đàm (Conversations). 
1.2. Sự khác nhau giữa To, Cc và Bcc
Khi gửi mail, thường là gửi cho nhiều người, bạn cần nhận biết sự khác nhau của To, Cc, Bcc để sử dụng cho đúng.

· To: Đối tượng chính. Bạn mong muốn họ nhận, xử lí mail và trả lời.

· Cc (Carbon Copy): Đối tượng có liên quan. Bạn muốn cho họ biết về thông tin trong email để họ có thể tham khảo, góp ý hay làm chứng nếu có tranh cãi.

· Bcc (Blind Carbon Copy): Đối tượng có liên quan. Bạn muốn cho họ biết thông tin trong email. Người nhận mail theo kiểu Bcc sẽ không thấy được địa chỉ email của những người khác. Những người khác cũng không thấy được địa chỉ email của người được gửi theo kiểu Bcc.

Để hiển thị Bcc, vào Options chọn Show Bcc.
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1.3. Đính kèm file vào Email

Để đính kèm file nào đó vào thông báo bạn gửi đi, bạn cần nhấp vào biểu tượng  Attach file, 
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chọn đường dẫn đến nơi lưu trữ file đó, chọn file bạn muốn gửi. Nhấn Insert hoặc phím Enter. Khi bạn gửi thư file đính kèm sẽ được gửi đi cùng thông báo.
1.4. Xem trước các file đính kèm trong email
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Trong Outlook 2010, khi bạn nhận được các tài liệu đính kèm ta có thể quan sát các file này trước khi mở chúng hoặc lưu về ổ đĩa. Nó giúp cho máy tính của bạn an toàn hơn, tránh lưu về các mã độc. 

Để xem được các file này ta nhấn vào biểu tượng file đó (như hình trên). Bạn có thể quan sát các file đó ở cửa sổ đọc (cột bên trái Outlook).

1.5. Chèn và chỉnh sửa hình ảnh trong Email
Để chèn ảnh vào nội dung thư bạn chọn Tab Insert, click chọn Picture trong nhóm Illustrations
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Chọn một hoặc nhiều hình để chèn vào trong nội dung email, khi đó các hình ảnh sẽ được hiển thị trực tiếp trong nội dung email. 
Để chỉnh sửa hình ảnh đã chèn bạn làm các bước sau: 

1) Chọn hình ảnh bạn đã đưa vào trong email. 

2) Bạn sẽ thấy hình ảnh xuất hình trên giao diện và các công cụ xung quanh nó. 

3) Bạn dùng các công cụ này để chỉnh sửa hình ảnh theo ý của bạn. 

Bạn cũng có thể sử dụng các công cụ trên với biểu đồ, bản vẽ, sơ đồ,...

1.6. Chữ ký trong Email

Cùng với sự phát triển của CNTT. Việc sử dụng Email hiện nay đã trở nên thông dụng và được coi là một kênh trao đổi thông tin chính thức và hiệu quả, đồng thời việc sử dụng chữ ký trong Email cũng làm tăng tính trang trọng, chuyên nghiệp cho Email của bạn.
Chữ ký của bạn có thể tự động được thêm vào thư gửi đi, hoặc bạn có thể tự thêm chữ ký để chỉ những thư mà bạn chọn.

Nội dung chữ ký Email

Nội dung chữ ký Email 
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Chữ ký của bạn bao gồm các thông tin về bạn, các nhà kinh doanh thì thường để thông tin liên lạc, để các khách hàng và đối tác của họ dễ dàng liên lạc với họ. 

Một chữ ký cũng có thể bao gồm một thông điệp tiếp thị hoặc thậm chí là một nơi yêu thích để thể hiện giá trị hài hước hay cá nhân 

Thông tin trong một email rất đơn giản với chữ ký có thể bao gồm: 

1) Tên của bạn. 

2) Chuyên môn của bạn. 

3) Địa chỉ và số điện thoại. 

Bạn cũng có thể thêm vào địa chỉ Website, hay một chữ ký bằng tay. Logo của công ty, hoặc hình ảnh của mình. 

Hình ảnh, hình ảnh, clip có thể làm chậm việc gửi Email. Do đó dung lượng của các đối tượng này phải tương đối nhỏ.

1.6.1. Cách tạo chữ ký trong Email

Mở một tin nhắn mới, trên tab Message, trong nhóm Include, nhấp chuột vào Signature, và sau đó bấm vào Signatures.
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Trên E-mail Signature tab, bấm vào New.
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Nhập tên cho chữ ký, và sau đó nhấn OK.
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Trong hộp thoại Edit signature, nhập văn bản mà bạn muốn bao gồm trong chữ ký.
Để định dạng văn bản, chọn văn bản, và sau đó sử dụng thanh công cụ bên dưới để định dạng.
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Lựa chọn hình thức chèn chữ ký (tự động hoặc bằng tay)

Trên tab Message, trong nhóm Include , nhấp chuột Signatures.
Bên dưới mục Choose default signature, Chọn e-mail account và chữ ký theo mặc định cụ thể như sau:
Trong hộp chọn của E-mail account: chọn tài khoản thư mà bạn muốn áp dụng.

Trong Hộp chọn phần New messages, nhấp chọn chữ ký mà bạn muốn chữ ký làm mặc định (để hệ thống chèn tự động) hoặc chọn None nếu muốn tự chèn khi soạn thư mới.

Trong Hộp chọn phần Replies /forwards, chọn chữ ký.  nhấp chọn chữ ký mà bạn muốn chữ ký làm mặc định (để hệ thống chèn tự động) hoặc chọn None nếu muốn tự chèn khi khi trả lời hoặc khi chuyển tiếp email.
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Chèn chữ ký bằng tay vào thư
Nếu bạn không chọn hình thức chèn chữ ký tự động và muốn chèn chữ ký khi soạn thảo thư thì làm như sau: Ở giao diện soạn thảo thư, bấm vào Signnature, nếu bạn đã tạo chữ ký trước đó, bạn sẽ thấy được liệt kê ở đây. Bạn chỉ cần chọn một chữ ký trong danh sách liệt kê.
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2. Quản lý danh bạ cá nhân.

Bạn có nhiều mối quan hệ, bạn không thể nhớ hết nghề nghiệp, địa chỉ … của từng người. Trong MS Outlook , Contacts có tác dụng lưu trữ thông tin của đối tác của bạn, để dễ dàng cho việc tìm kiếm. Bạn có thể lưu bất kỳ thông tin của ai trong Contacts.
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Tạo một contact (thông tin liên hệ)

Bạn muốn lưu lại nhưng thông tin người gửi email cho bạn, thì chính Outlook là một công cụ tuyệt vời về quản lý danh sách các tên và địa chỉ và nó dễ sử dụng như sổ tay nhỏ của bạn.
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Để nhập một contact mới, nhấn nút Contacts trong Navigation Pane, sau đó nhấp nút New trên thanh công cụ để mở form nhập New Contact. Điền vào các chỗ trống trên form và sau đó nhập Save and Close. .
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Tạo Contact từ email đã nhận

Mở hoặc xem trước e-mail có chứa tên mà bạn muốn thêm vào danh sách liên lạc của bạn.
Nhấp chuột phải vào tên của người mà bạn muốn, sau đó nhấp Add to Contacts.
Lưu ý: Trong Outlook, không có tùy chọn để thêm thông tin liên lạc tự động vào Danh bạ hoặc sổ địa chỉ khi bạn trả lời cho một contact.
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Tạo Contact Group trong Microsoft Outlook

Nếu bạn thường xuyên gửi email trong cùng một nhóm của người nhận, một Contact Group có thể là một thực tế tiết kiệm thời gian. Khi đó, mỗi lần nhập địa chỉ, thay vì phải thêm mỗi địa chỉ với mỗi người nhận, bạn chỉ cần nhập tên Contact Group (mà bạn đã thêm vào tất cả các địa chỉ liên lạc của những người trong nhóm. Người dùng có thể tạo nhiều Group Contact khác nhau để phục vụ nhu cầu gửi Email theo nhóm của mình.

Bước1: Click Tab Home -> chọn New Contact Group.
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Bưới 2: Tại khung Name: gõ tên Group
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Bước3: Nhìn lên thanh Ribbon, click chọn Add Members.
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Ở đây có 3 tùy chọn:

(1) From Outlook Contacts: để thêm người nhận đã có trong Contacts của bạn.
(2) From Address Book: để thêm người nhận từ sổ địa chỉ của cả Hệ thống Email. Đây là tuy chọn rất rộng, bao gồm nhiều tùy chọn con (trong đó có cả tùy chọn From Outlook Contacts đã giới thiệu ở trên) bao gồm tất cả các địa chỉ mail của NHNN, các địa chỉ/nhóm địa chỉ đã được thêm vào danh sách contact trên máy chủ mail NHNN,…..:
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Với (1) và (2) người dùng chỉ việc kích đúp vào tên những người nhận, kích OK để hoàn tất việc thêm Member (bỏ qua bước 4).

(3) New Email Contact: Thêm một Contact mới (chưa có trong số địa chỉ) vào Contacts Group. Bước 4 sẽ hướng dẫn cho người dùng kích vào tùy chọn này:
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Bước 4: Ở hộp thoại Add New Member, người dùng chỉ cần nhập Tên hiển thị và địa chỉ Mail của Member đó. Tuy nhiên, ở đây cần lưu ý thêm về tùy chọn “Add to Contacts”:
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Nếu tùy chọn “Add to Contact” được chọn (như mặc định) thì Member này cũng đồng thời được thêm vào danh sách Contacts của bạn, bạn có thể vào Contacts Listc để cập nhật thêm các thông tin liên quan khác như với những Contact khác của bạn. Tuy nhiên, nếu bạn chỉ muốn Member này nằm trong Group bạn đang tạo mà không nằm ngoài Contacts List nữa (vì sẽ làm cho Contact List trở nên nhiều, rối mắt, khó quản lý) thì hãy bỏ Check ở “Add to Contact”
Bước 5: Click Save & Close lưu lại thông tin về nhóm (tên, các thành viên) vừa tạo
Gửi thư cho Contact, Contact Group
Để gửi thư cho Contact, Contact Group, Khi ở cửa số soạn thảo thư, bạn kích chuột vào ô nhập địa chỉ người nhận (To hoặc Cc): Kích chọn Address book => Tại cửa sổ Select name:… hiện ra như sau: 
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Ở đây người dùng chọn Address Book là Contacts sẽ nhìn thấy các Contacts và Contacts Group bạn đã tạo, chỉ cần Kích chọn các Contact hoặc Contacts Group mà bạn muốn gửi email, click OK

3. Quản lý công việc với outlook
3.1. Lập và quản lý nhiệm vụ
3.1.1. Tạo một nhiệm vụ (công việc cần thực hiện)
Tính năng quản lý công việc (Tasks) của MS Outlook giúp người dùng quản lý, nhắc nhở công việc của chính mình, giao việc cho nhân viên và theo dõi đốc thúc nhân viên, biết được hôm nay, ngày mai, tuần tới… phải làm gì, việc gì ưu tiên, việc gì đã giao mà chưa xong… 

Để tạo nhiệm vụ bạn thực hiện theo các bước sau:

1   Nhấp nút Tasks trong Navigation Bar. 
     Danh sách các tác vụ xuất hiện. 
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2   Nhấp text ghi là Type a New Task. 

     Các từ biến mất, và bạn thấy con trỏ (một đường nhấp nháy). 

3   Gõ nhập tên của nhiệm vụ.
4   Nhấn phím Enter. Nhiệm vụ xuất hiện trong khối bên dưới dòng Subject trên Task List
Nhiệm vụ  mới di chuyển xuống Task List với các nhiệm vụ khác với các tham số mặc định do chương trình gán. Tuy nhiên nếu người dùng muốn thay đổi các thông tin này thì  có thể kích đúp chuột vào một nhiệm vụ để chỉnh sửa các thông tin hoặc cập nhật tiến độ của nhiệm vụ.

Hoặc người dùng có thể kích vào nút New task trên Ribbon để nhập các thông tin về nhiệm vụ ngay từ đầu.
3.1.2. Đánh dấu các nhiệm vụ đã hoàn tất 
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Các nhiệm vụ khi hoàn thành xong bạn có thể xóa nó đi, nhưng hãy đánh dấu những nhiệm vụ đã hoàn thành thay vì xóa nó, như vậy sẽ hay hơn. 

Để đánh dấu một nhiệm vụ đã hoàn tất, làm theo các cách sau: 

Cách 1: Nhấp chuột trái vào cờ của nhiệm vụ bạn muốn đánh dấu hoàn thành.
Cách 2: Nhấp chuột trái vào ô checkbox trước tiêu đề của nhiệm vụ.

[image: image26.png]0 subject Created  ~ le.|¥ | "

30

Click here o add a new Task dois

fask ) Hai30062014 212CH ¢ 1

T Nesttor Céch 2 Hai3006/2014 1103 .. Y 2

27 © FW: DE_ B0 TTTT ngay 4/11/2013 v cung cip théng tn v.. Tu06/11/201310:37 SA EY

5 7 © FW: Ban Word_Cau hoi khao sat cua Gymasis S50 03/05/2013 851 54 4

(4[] ® FW: DE504. Cu can bo tham gia de tai VPNHNN Nim 18/04/2013 103,

(30 RE Vehoi nghitructuen S0BO32013430.. W Mo
(217 @ RE bao cao NCKT_update, Du toan tong hop Tu06/03/2013556 CH W
(2 Bitn ban nghiém thu két qus khdo sat Ba0SN01310525A ¥




Cách 3: (Nên dùng khi đánh dấu nhiều nhiệm vụ đứng cạnh nhau): Tô sáng các nhiệm vụ cần đánh dấu hoàn tất rồi nhấp chuột trái vào nút Mark Complete
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Cách 4: Click chuột phải vào nhiệm vụ muốn đánh dấu hoàn thành, chọn Mark Complete.
Sau khi được đánh dấu hoàn thành, tên của nhiệm vụ thay đổi màu và có một đường thẳng xuyên qua nó giống như ký hiệu gạch bỏ.
Chọn cách xem danh sách các nhiệm vụ

Tùy theo yêu cầu và thói quen mà bạn có thể chọn cách xem danh sách các nhiệm vụ cho phù hợp bằng cách lựa chọn cách cách xem trên Ribbon:
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Trong đó:

· Detailled: Danh sách hiển thị đầy đủ tất cả các thông tin của nhiệm vụ.
· Simple List: Danh sách hiển thị đơn giản, chỉ hiển thị một số trường chính
· To-Do List: Danh sách hiển thị tên các nhiệm vụ.
· Prioritized: Danh sách hiển thị các nhiệm vụ được phân nhóm theo mức độ ưu tiên.
· Active: Danh sách hiển thị các việc đang cần làm.

· Complete:Danh sách hiển thị các việc đã hoàn thành.

3.2. Sử dụng Calendar quản lý lịch làm việc
Không chỉ đơn thuần là phần mềm dùng để gửi nhận email. Outlook còn là một công cụ đắc lực giúp bạn quản lý thời gian làm việc của mình. Bạn có thể thiết lập cho Outlook tự động thông báo lịch làm việc cho bạn theo ngày, tuần hoặc tháng trong phần Calendar (lịch). Tính năng Calendar cần thiết cho ai thường xuyên phải sắp xếp thời gian gặp khách hàng, hội họp. Người dùng còn có tùy chọn nhắc lịch làm việc theo giờ, theo ngày (dòng nhắc nhở hiện trên màn hình theo lịch hẹn)… Thông tin lịch làm việc của từng cá nhân trên thư mục dùng chung còn giúp người dùng biết đồng nghiệp khi nào bận công tác, nghỉ ốm…

Để vào mục Calendar trong Outlook, người dùng click chuột vào thanh Calendar bên trái cửa sổ mail.

Lúc này bạn sẽ thấy cửa sổ Calendar hiện ra, click chọn nút Day, Work Week, Week, Month trên thanh công cụ để xem lịch ngày, tuần hoặc tháng. 
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Click đúp chọn một thời điểm trong khung Calendar để tạo một lịch hẹn. Cửa sổ Untitled - Appointment xuất hiện để bạn điền thông tin việc cần làm.
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Điền tên công việc và nơi thực hiện công việc trong khung Subject và Location.
Chọn mức độ quan trọng của công việc trong khung Label.

Chọn thời gian bắt đầu và thời gian kết thúc công việc trong khung Start Time và End Time. Nếu là sự kiện cả ngày bạn có thể click chọn dòng All day event.

Để Outlook tự động thông báo khi lịch đến, bạn phải click chọn dòng Reminder. Tốt nhất bạn nên chọn khoảng thời gian thông báo trước 10, 15 hoặc 30 phút... trong khung kế bên.

Bạn cũng có thể chọn chuông báo là một file nhạc có định dạng đuôi .wav thay vì dùng âm báo mặc định của Outlook. 
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Cuối cùng nhấp Save and Close để lưu và đóng lại những thiết lập vừa thực hiện. Như vậy, khi có lịch đến Outlook sẽ tự động bật bảng thông báo công việc kèm theo bài nhạc bạn đã chọn.

3.2.1. Kiểm tra Calendar 
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Khi vào Calendar bạn có thể nhìn thấy những nhiệm vụ, lịch các cuộc hẹn hay các sự kiện mà bạn đã tạo ra trong calendar. Cách xem nhiệm vụ trong Calendar: 

Nhấn vào biểu tượng lịch. 

Click vào một ngày trên lịch, bạn sẽ thấy các nhiệm vụ hoặc các cuộc hẹn mà bạn đã sắp xếp sẽ xuất hiện trên To-Do Bar. 
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Khi cần tìm ngày tháng trên lịch thì bạn có thể công cụ ở phía trên để di chuyển ngày tháng một cách dễ dàng: 

1 Nhấn vào Day, Week, Mooth để nhanh chóng chuyển đổi thời gian ngày tháng muốn xem. 

2 Dùng phím mũi tên để di chuyển ngày tháng một cách tiện lợi

3 Có thể cho hiển thị hoặc ẩn ngày phụ thuộc vào cách xem của bạn.

3.2.2. Chọn lựa cách lập biểu trong Calendar 
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Bởi vì các yêu cầu khác nhau, nên bạn phải lập biểu khác nhau cho các yêu cầu đó. 

Cuộc hẹn: Một cuộc hẹn cần diễn ra chính xác theo thời gian, do đó ta sẽ lập biểu tại một thời gian. 

Cuộc họp: Một cuộc họp xảy ra tại một thời gian, dự kiến, giống như một cuộc hẹn. Sự khác biệt là bạn sẽ mời những người khác bằng cách sử dụng một cuộc họp yêu cầu được gửi qua email. 

Sự kiện: Một sự kiện là một hoạt động kéo dài cả ngày dài. Không giống như một cuộc hẹn hoặc cuộc họp, một sự kiện. Với một sự kiện, bạn vẫn có thể có các mục xuất hiện trong lịch trình của bạn cho ngày hôm đó. 

Nhiệm vụ: Một nhiệm vụ là một yêu cầu bạn làm gì đó trong một khoảng thời gian, bạn có thể lập biểu nhiệm vụ cho mỗi ngày 
3.2.3. Tạo lịch cho các cuộc họp
Để mời một số người tham gia cuộc họp, cần làm như sau: 

1) Chọn File > New > Meeting Request (hoặc nhấn Ctrl+ Shift+Q). 
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Form New Meeting mở ra. 
2) Nhập hoặc chọn địa chỉ Email của những người bạn muốn mời họp.

Để kiểm tra lịch của những người dự định mời họp,Click nút Scheduling.

3) Nhập tiêu đề thư mời họp.
4) Chọn phòng họp (Nếu danh sách các phòng họp của đơn vị được quản lý bởi Hệ thống Email)

5) Chọn ngày và nhập thời gian diễn ra cuộc họp.
6) Click Send. 

Yêu cầu tham gia cuộc họp của bạn được gửi đến thành phần tham dự. 

Khi xem Mail trên Outlook, người nhận yêu cầu tham gia cuộc họp sẽ nhìn thấy nút Accept (đồng ý) và Reject (từ chối). Nếu tham dự được thì người nhận nhấn   Accept, khi đó lịch họp sẽ tự động được gán vào lịch của họ và sẽ có thông báo nhắc nhở như thiết lập của người gửi. 
4. Quản lý hộp thư về dung lượng và lưu trữ
 Xác định kích thước hộp thư và làm giảm dung lượng 

Dung lượng của Email 

Hệ thống Email NHNN cho phép gửi/nhận các thư có dung lượng từ 20Mb trở xuống , do đó các email có dung lượng trên 20Mb sẽ bị chặn.

4.1.1. Xem dung lượng hộp thư 

Hộp thư của bạn sẽ không thể gửi/nhận thư được nếu dung lượng hộp thư bằng hoặc vượt quá dung lượng giới hạn (hộp thư bị đầy). Hiện tại giới hạn dung lượng hộp thư của người dùng trong hệ thống Email NHNN là 2Gb. Do đó, bạn cần phải quản lý dung lượng của Email.

Để kiểm tra nhanh dung lượng hộp thư của mình bạn có thể làm như sau:

· Trên Outlook 2010: Kích chọn menu File => quan sát hình ảnh biểu thị dung lượng trong mục Mailbox Cleanup:
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· Trên trình duyệt: Di chuột đến phần tên hiển thị hộp thư của bạn sẽ thấy hiện lên thông báo tình trạng dung lượng hộp thư của bạn:
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Để kiểm tra dung lượng chi tiết của từng mục/thư mục trong hộp thư bạn cần làm như sau: 

Click phải vào thư mục > Properties
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Ở hộp thoại Properties, để xem dung lượng của mục/thư mục đã chọn, bạn nhấn vào mục Folder Sizes. 

4.1.2. Sử dụng Mailbox Cleanup để kiểm tra dung lượng và dọn dẹp hộp thư
Như trên đã trình bày, bạn có thể dễ dàng qua kiểm tra dung lượng của bạn khi vào mục File >Info > Mailbox Leanup. Ở đây bạn có thể sử dụng Cleanup Tools để đễ dàng lọc và xóa các thư có dung lượng lớn để giải phóng dung lượng cho hộp thư của bạn. Cụ thể như sau:
Ở hộp thoại Mailbox Cleanup, người dùng có thể xem cụ thể dung lượng các thư mục, lọc các thư cũ, lọc các thư dung lượng lớn, làm rỗng thùng rác,.....
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4.1.3. Lưu các tập tin đã đính kèm vào ổ đĩa 
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Sau khi xem qua dung lượng của các Email, bạn sẽ nhận thấy rằng các Email có dung lượng lớn thường bao gồm những tài liệu đính kèm. Nếu cần để lưu trữ các tài liệu đính kèm trong hộp thư. Bạn sử dụng Lưu tập tin đính kèm các lệnh của Microsoft Office và lưu các tài liệu đính kèm vào một số vị trí thuận tiện trên đĩa cứng của bạn. 

Sau khi đã lưu các tệp đính kèm, bạn có thể xóa các Email không cần thiết đó. 

Trước khi bắt đầu lưu tài liệu đính kèm vào đĩa cứng, phải nhớ vị trí đã lưu để sau này người dùng có thể xem lại các tài liệu đó. Để lưu tập tin đính kèm vào ổ đĩa bạn làm theo các bước sau: 

1) Mở Email có chứa tập tin đính kèm. 

2) Nhấn vào Tab File

3) Sau đó bạn chọn Save attachments. 

4) Chọn đường dẫn để lưu tập tin, sau đó nhấp Ok

4.1.4. Xóa vĩnh viễn các Email ra khỏi hộp thư 
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Mỗi khi bạn xóa một email, nó đi vào thư mục Deleted Items.Khi xoá nhiều thì thư mục này có thể phát triển nhanh chóng và chiếm nhiều dung lượng, do đó cần phải làm sạch thư mục Deleted Items cũng như dung lượng của toàn hộp thư. Bởi vậy, nên xóa vĩnh viễn các Email này ra khỏi hộp thư. 

Cách xóa vĩnh viễn các Email đơn giản nhất là vào thư mục Deleted Items, bạn sẽ thấy các Email xóa bên ngoài. Nhấp chuột vào các Email này, nhấn chuột phải chọn Delete. 
Ngoài ra bạn có thể xoá vĩnh viễn các Email bằng lệnh. Bạn nhấn chuột phải vào thư mục Deleted Items chọn Empty Folder, chọn Ok. Vậy là tất cả các Email trong thư mục Deleted Items đã được xoá ra khỏi hộp thư của bạn. 

4.1.5. Tác dụng của Junk Mail 

Junk Mail có tác dụng lọc thư rác (Spam mail), giúp cho ta phân loại được thư rác như các thư quảng cáo, .... Junk Mail cũng là nơi chứa các thư rác đó. Junk Mail không muốn các Email rác nằm lẫn lộn với các Email cần thiết.

Thư rác hay spam đang ngày càng trở thành một vấn đề nghiêm trọng và nếu bạn càng phụ thuộc vào thư điện tử bao nhiêu thì nó càng gây khó chịu cho bạn bấy nhiêu. Bạn xác định khối lượng lọc mà bạn cần và bất cứ thứ gì mà Outlook cho là spam sẽ được đưa vào bộ lọc Junk Mail Filter để xem xét. Bạn cũng có thể thiết lập một danh sách an toàn để bạn có thể bổ sung các địa chỉ thư điện tử từ những nguồn tin cậy vào đó. Nếu một thư điện tử từ một nguồn tin cậy tình cờ chui vào trong thư mục Junk, việc bổ sung người gửi đó vào danh mục an toàn Safe List (hoặc Not Junk Mail) rất dễ dàng.
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4.2. Di chuyển hoặc sao chép thư vào các thư mục cá nhân 

4.2.1. Căn bản về kho lưu trữ 

Kho lưu trữ Mail trên Outlook bao gồm:
· Phần hộp thư: đồng bộ dữ liệu trực tiếp với máy chủ

· Phần thư mục cá nhân (Archive): Chỉ lưu trữ trên máy cá nhân, không đồng bộ với hộp thư trên máy chủ. Do người dùng trực tiếp chuyển thư vào hoặc đặt lệnh cho hệ thống di chuyển tự động (trình bày chi tiết trong mục 3.3) 

4.2.2. Lưu các email vào thư mục cá nhân 
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Bạn muốn có một thư mục cá nhân chứa các tập tin riêng của bạn, điều đó tương tự để có một tủ đựng các hồ sơ cá nhân. Với thư mục cá nhân, bạn tạo tập tin riêng cho mình. Sau khi bạn đã tạo ra thư mục cá nhân và cách di chuyển các tập tin vào thư mục cá nhân này.

4.2.3. Cách tạo các thư mục cá nhân 

Để sử dụng một thư mục tập tin cá nhân, trước tiên bạn cần phải tạo ra nó. Để tạo thư mục cá nhân bạn làm theo các bước sau: 
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1 Chọn file sau đó nhấn vào Info chọn Account Settings 
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2 Bạn chọn tiếp Tab Data Files 
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3 Chọn Add, nhập tên 

4 Thư mục cá nhân của bạn đã được tạo ra như hình dưới.
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4.2.4. Cách chọn các subfolder trong thư mục cá nhân 

[image: image48.png]8 open n NewWindow

Open File Location.

T Close My Outook osa ik





Sau khi bạn tạo xong thư mục cá nhân, bạn có thể tạo thêm các thư mục con subfolder trong thư mục cá nhân. Bạn làm điều này từ Cửa sổ Danh mục chính: 

Nhấn chuột phải vào thư mục My Outlook Data File(1) chọn New Folder. 

Đặt tên cho thư mục vừa tạo, nhấn OK. 

Sau đó bạn sẽ thấy một thư mục con trong thư mục cá nhân của bạn.
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4.2.5. Di chuyển Email vào thư mục cá nhân 

Sau khi bạn đã tạo xong các thư mục con trong thư mục các nhân. Để để di chuyển một hoặc nhiều Email đến thư mục con, bạn làm theo các bước sau: 

1 Nhấn chuột phài vào Email chọn Move to Folder 

2 Bạn chọn thư mục con trong thư mục cá nhân và nhấn OK. 
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Những cách khác để di chuyển các Email vào thư mục cá nhân là dùng phương pháp kéo thả. 

Bạn nhấn chuột trái vào Email, giữ chặt chuột và di chuyển chuột tới thư mục con trong thư mục cá nhân, sau đó bạn thả chuột ra, Email đó sẽ xuất hiện trong thư mục cá nhân.

4.2.6. Lưu trữ emai ra ổ đĩa 

Thông thường bạn lưu trữ các Email vào thư mục cá nhân. Nhưng các thư mục này vẫn nằm trong Outlook. Tuy nhiên có cách để back up dữ liệu khác là lưu trữ các Email vào ổ đĩa. 
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File > Info > Account Settíng 
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Tab Data Files > chọn dòng muốn lưu trữ hoặc di chuyển > Open File Location
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Chọn Move this file hoặc Copy this file

Lưu ý: Nếu mục tiêu của bạn là để sao lưu toàn bộ hộp thư của bạn, thì bạn mới dùng công cụ này.

Phân loại thư

Đôi khi tài khoản email của bạn sẽ bị quá tải do mỗi ngày bạn phải nhận hàng trăm email từ khách hàng, đối tác, nội bộ công ty. Do đó, việc phân loại tự động email sẽ giúp giảm bớt thời gian rất nhiều. Để thực hiện phân loại thư tự động, ta có thể tạo các Rule trên hộp thư cá nhân. Việc tạo Rule có thể thực hiện khi người dùng sử dụng thư trên trình duyệt hoặc sử dụng MS Outlook. Tuy nhiên MS Outlook trang bị cho chúng ta rất – rất nhiều tùy chọn cho việc tạo Rule. 

4.2.6.1. Hướng dẫn tạo Rule trong mọi trường hợp:

Để tạo một Rule theo cách tổng quát nhất ta làm như sau:

Bước 1: Kích chọn vào File:
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Bước 2: Chọn Manager Rule & Alert:
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Bước 3: Trong cửa sổ Rule & Alert, Tab E-mail Rule sẽ nhìn thấy tất các các Rule mà bạn đã có, nếu Rule nào được tích chọn ở đầu nghĩa là Rule đó đang được kích hoạt còn Rule nào không được tích chọn có nghĩa Rule đó dù vẫn tồn tại nhưng bị vô hiệu hóa, việc kích hoạt hay vô hiệu hóa Rule nào là phụ thuộc vào việc kích chuột của bạn. 
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Với một Rule đã có, có thể thực hiện các thao tác sau: Change Rule (chỉnh sửa Rule), Copy Rule (sao chép Rule), Delete (xóa điều kiện), Run Rules Now  (thực hiện ngay một điều kiện nào đó). Nếu bạn muốn thực hiện các thao tác này với một Rule nào đó thì phải kích chuột vào tên Rule đó trước khi kích vào thao tác muốn thực hiện. (Ví dụ như với hình trên thì thao tác sẽ được thực hiện với Rule thứ 2 (là Rule đang được tô sáng) chứ không phải là Rule thứ 3, 4 (là các Rule đang được kích hoạt)).
Để tạo một Rule mới bạn kích chọn vào New Rule:
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Bước 4: Ở Cửa sổ tạo Rule, bạn sẽ thấy có rất nhiều tùy chọn tạo Rule, bạn chỉ việc chọn các tùy chọn đó theo yêu cầu tạo Rule của mình, nhưng lưu ý rằng với mỗi tùy chọn tại ô “1”, bạn cần thiết lập tham số cho các đối tượng của tùy chọn đó ở ô 2 bằng cách kích vào các link màu xanh ở ô này:
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Ví dụ ở các cửa số tiếp theo:
· Chọn điều kiện cho quy tắc nhận email
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· Chọn hành động (action) cho quy tắc nhận thư
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· Chọn điều kiện loại trừ cho quy tắc nhận thư
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· Xem tổng quan lại, đặt tên cho Rule và nhấn Finish để hoàn tất 
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(Nếu tại bước này bạn tích chọn Run this Rule now on messages already in “Inbox” thì Rule sẽ được áp dụng cho cả các thư cũ trong hộp thư. Thao tác này cũng giống như thao tác chọn Run Rule Now trình bày ở bước 5)

4.2.6.2. Tạo Rule nhanh
Để tạo các Rule đơn giản, chúng ta có thể thực hiện thao tác này nhanh hơn bằng cách “đi đường tắt”. Dưới đây là hướng dẫn một số các tạo Rule thông dụng:
a. Thay vì tạo Rule trên MS Outlook, chúng ta có thể tạo Rule khi sử dụng Email trên trình duyệt, tuy ở đây không nhiều tùy chọn như trên MS Outlook, nhưng các tùy chọn ở đây cũng khá thoải mái cho nhu cầu tạo Rule cơ bản. Để Tạo Rule trên trình duyệt, bạn kích vào Options => Create an Inbox Rule: 
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b. Tạo Rule: chuyển toàn bộ từ một người gửi nào đó vào một thư mục:

B1: Kích chuột phải vào một thư nhận được từ người gửi đó, chọn Rules => Always Move Messages From: <người gửi>…. Ví dụ như hình:
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B2: Ở hộp cửa sổ Rules & Alerts hiện ra, bạn chỉ cần chọn thư mục để chứa những thư đến từ người gửi đó. Trong trường hợp thư mục bạn định lưu trữ chưa có thì hãy kích chuột để chọn thư mục cha của thư mục định tạo rồi nhấp chuột chọn “New…”
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c. Tạo Rule áp dụng với một người gửi nào đó
B1: Nhấn chuột phải vào tiêu đề một thư nhận được từ người gửi đó. Chọn Rules => Create Rules. 
[image: image66.png]HWE AR PO &E

Copy
Quick Print

Reply

Reply All

Forward

Mark 3s Unread
FollowlUp  »
FndRelated >

Quicksteps >
More adtions >

6/10/2008
0o

6/10/2008
0o

6/15/2008
Y

6/16/2008.
o

6/17/2008
o

6/17/2008
o

6/18/2008
Y

X - &4

Move »
Ianore

Junk »
Undelete

Delete.

) Manage Rues & et





B2: Trong cửa sổ mới, ta thiết lập quy tắc cho email gửi đến tương ứng với yêu cầu công việc. 
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Ở đây ta chọn Select Folder
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Chọn thư mục đã được tạo sẵn hoặc nhấn nút New để tạo thư mục khác, rồi nhấn OK

Trong mục  "Move the item to folder" sẽ giúp tự động đưa tất cả email từ một địa chỉ email xác định vào một thư mục được chỉ định sẵn. 
Bạn có thể thiết lập các tùy chọn nâng cao bằng cách nhấn vào nút Advanced Options, khi đó việc thiết lập các tùy chọn giống như đã trình bày trong mục 4.2.7.1. 
Lưu trữ các thư từ cũ 

Làm quen với AutoArchive 

Để vào hộp thoại AutoArchive bằng cách nhấp chuột vào File chọn Options. 

Nhấp chuột vào Advanced và sau đó nhấp chuột vào nút AutoArchive Settings. 

Hộp thoại Auto Archive hiển thị.
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1 Nếu chọn Run AutoArchive every (số ngày) thì AutoChive sẽ kiểm tra hộp thư tùy theo số ngày bạn chọn. (Và nếu bạn không thích AutoArchive, bạn có thể không chọn nó). 

2 Số lượng ngày cho biết với tần số mà AutoArchive sẽ chạy. 

4.2.7. Xác định Email cũ trong AutoArchive 



Với AutoArchive, mỗi lần Email bị di chuyển sẽ nhận được một thông báo kiểm tra. Tuy nhiên, đôi khi bạn không nhận được thông báo kiểm tra, do AutoArchive được cài đặt mặc định. Sau khi di chuyển thì những Email đó được cho là cũ và bạn có thể thay đổi điều này. 

Đối với một số người Email có vẻ cũ sau khi hai tuần, nhưng đối với người khác thì có thể là 2 tháng. Bạn là một được quyết định và bạn có thể làm được điều này trên một cơ sở cho mỗi thư mục nếu bạn muốn. 
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